
Unpacking Your Printer 

 

1. Select a location for your printer. 
 

l Leave enough room to open the printer tray, covers, doors, and options. It is also important to allow enough space around the printer for proper 
ventilation.  
 

l Provide the proper environment:  
 

l A firm, level surface 
 

l Away from the direct airflow of air conditioners, heaters, or ventilators 
 

l Away from sunlight, extreme humidity, or wide fluctuations in temperature 
 

l A clean, dry, and dust-free location  
 

2. In addition to the Dell Laser Printer 1110, ensure that you have the following items in the box. If there is a missing item, contact Dell:  
 

 
a.  The appearance of the power cord may differ according to your country's specifications.  
b.  The Drivers and Utilities CD contains the Dell printer driver, Dell™ Toner Management System, and an HTML User's Guide.  

3. Save the carton and packing material in case the printer needs to be repacked. 
 

4. Remove the packing tape from the printer. 
 
 

  
 
 

About Your Printer  

These are the main components of your printer. The following illustrations show the standard Dell Laser Printer 1110: 

  

Front View 

 NOTE: Leave the printer in the box until you are ready to set it up.

  

Starter Toner 
Cartridge  

  

Power Corda  

 

Drivers and Utilities 

CDb  

  

Owner's Manual 

 

Setup Diagram 

 NOTE: The power cord must be plugged into a grounded power socket.



  

  

   

Rear View 

  

  

  

  

Operator Panel Button Functions 

The operator panel on the top right side of your printer has two LEDs and one button.  

 

 LEDs 

  

Button 

LED Description 

  

The operator panel LEDs signify different things, depending on their sequence. LEDs that are off, on, and/or blinking indicate printer 
conditions, such as printer status, intervention (for example, out of paper and jammed paper), or service. For more information on what the 
LEDs sequence means and what you can do, see "Understanding the Operator Panel LEDs". 

Item Description 



  

Installing the Starter Toner Cartridge  

1. Open the front cover. 
 
 

  
 

2. Unpack the starter toner cartridge from its package and thoroughly shake the cartridge from side-to-side 5 or 6 times to distribute the toner evenly 
inside the cartridge. 
 

  

Thoroughly rolling the cartridge will assure maximum copies per cartridge. 

2.

 

3. Pull the tape to remove the protective paper. 
 

 
 
 

4. Locate the cartridge slots inside the printer, one on each side. 
 
 

To print a demo page In Ready mode, press and hold  for 2 seconds until both LEDs blink slowly, and release.  

Manual feeding Press  each time you load a sheet of paper in the tray, when you select Manual Feed for Source from your software 

application. 

For detailed information, see "Using Manual Feed Mode". 

To cancel a print job Press  during printing.  blinks red while the print job is cleared from both the printer and the computer, and the printer 

then returns to Ready mode. This may take some time depending on the size of the print job.  

In Manual Feed mode, you can't cancel the print job by pressing . 

Manual Duplex feeding Press  each time you load the paper back in the tray after the first side of your job has printed while manual duplex printing. 

For detailed information, see "Printing on Both Sides of Paper (Manual Duplex)". 

 NOTE: If toner comes into contact with your clothing, wipe the toner off with a dry cloth and wash your clothing in cold water. Hot water 
sets toner into fabric.

 CAUTION: To prevent damage to the toner cartridge, do not expose the toner cartridge to light for more than a few minutes.

 CAUTION: Do not touch the green underside of the toner cartridge. Use the handle on the cartridge to avoid touching this area. 
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5. Unfold the toner cartridge handle and grasp it. Insert the cartridge into the printer until it snaps into place. 
 
 

  
 
 

6. Close the front cover. Make sure that the cover is securely closed. If the cover is not firmly closed, printing errors may occur. 
 

  

Loading Paper 

Load up to 150 sheets of plain paper in the paper tray. 

  

  

To load paper: 

1. Open the paper input tray. Pull on the length and width guides to extend the tray. 
 
 

  
 
 

2. Flex the sheets back and forth to loosen them, and then fan them out. Do not fold or crease the print media. Align the edges on a level surface. 
 
 

  
 
 

3. Load the paper stack in the paper tray with the side to be printed on facing up. 
 
 

 NOTE: When printing text at 5% coverage, you can expect a toner cartridge life of approximately 1,000 pages for the starter toner 
cartridge that is shipped with the printer (2,000 pages for a standard toner cartridge).

NOTE: To print a document, set the paper type and size in your software application after loading paper into the paper tray. See "Paper Tab".
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Make sure that all four corners are flat in the tray. 

4. Be careful not to overload the paper tray. Overloading may cause paper jams. 
 

5. Squeeze the length guide and slide it until it lightly touches the end of the paper stack. 
Squeeze the width guide and move it toward the stack of paper until it lightly touches the side of the stack.  
 
 

  
 

  

Connecting a Printer Cable 

  To print from your computer, you need to connect your printer to your computer with a Universal Serial Bus (USB) cable. USB cables are sold separately. 
Contact Dell to purchase a USB cable.  

  

To connect the printer to a computer: 

1. Make sure the printer, computer, and any other attached devices are powered off and unplugged. 
 

2. Connect a USB cable to the USB cable connector on your printer 
 
 
 

  
 
 

3. Insert the other end of the cable into an available USB port on the computer. Do not use the USB keyboard port.  

  

Powering On the Printer  

NOTE: Improper adjustment of paper guides can result in paper jams.  

  

 NOTE: Connecting the printer to the USB port of the computer requires a certified USB cable. You will need to buy a USB 1.1 compliant cable that 
is 3 m or less in length.



  

To power on the printer: 

1. Plug one end of the power cord into the power cord connector at the back of the printer and the other end into a properly grounded outlet.  
 

2. Press the power switch to power on the printer. 
 
 

 

  

Printing a Demo Page  

Print a demo page to make sure that the printer is operating correctly. 

1. Wait approximately 30 seconds for the printer to warm up, then press and hold  on the operator panel for 2 seconds to print a demo page. 

 
 

  
 
 

2. The Demo page shows the printer's current configuration. 
 
 

  
 
 

  

  

  

  

 CAUTION: The fusing area at the rear part of the inside of your printer becomes hot once the printer is powered on. Be careful not to be burned 
when you access this area. 

 CAUTION: Do not disassemble the printer when it is powered on. If you do, you may receive an electric shock. 



Finding Information 

  

What Are You Looking For? Find It Here 

• Drivers for my printer

• My User's Guide

Drivers and Utilities CD  

  

You can use the Drivers and Utilities CD to install/uninstall/reinstall drivers and utilities or to access your User's Guide. 
For details, see "Software Overview". 

Readme files may be included on your Drivers and Utilities CD to provide last-minute updates about technical changes 
to your printer or advanced technical reference material for experienced users or technicians.  

• Safety information

• How to use my printer

• Warranty information

Owner's Manual  

 

 CAUTION: Read and follow all safety instructions in your Owner's Manual prior to setting up and operating 
your printer. 

How to set up my printer Setup Diagram  

 

Express Service Code Express Service Code  

  

Identify your printer when you use support.dell.com or contact technical support. 

Enter the Express Service Code to direct your call when contacting technical support. The Express Service Code is not 
available in all countries. 

• Latest drivers for my printer

• Answers to technical service and 
support questions

• Documentation for my printer 

Dell Support Website 

The Dell Support Website provides several online tools, including: 

You can access Dell Support at support.dell.com. Select your region on the WELCOME TO DELL SUPPORT page, and 
fill in the requested details to access help tools and information. 

• Solutions- Troubleshooting hints and tips, articles from technicians, and online courses 

• Upgrades- Upgrade information for components, such as memory

• Customer Care- Contact information, order status, warranty, and repair information

• Downloads- Drivers

• Reference- Printer documentation and product specifications  
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Maintenance  

   

  

 

Cleaning Your Printer 

 To maintain print quality, follow the cleaning procedures below, each time the toner cartridge is replaced or if print quality problems occur. 

  

Cleaning the Exterior 

 Clean the printer cabinet with a soft, damp, and lint-free cloth. Do not let water drip onto the printer or inside the printer. 

  

Cleaning the Interior 

 Paper, toner, and dust particles can accumulate inside the printer and cause print quality problems, such as smearing or toner specks. Clean inside the printer 
to prevent these problems. 

1. Power the printer off and unplug the power cord. Wait approximately 10 minutes for the printer to cool down. 
 

2. Open the front cover. 
 

  
 
 

3. Gently pull the toner cartridge out, being careful not to scratch against the printer, and lift it up and away from the printer. Set it on a clean flat surface. 
 

  
 

4. With a dry and lint-free cloth, wipe away any dust and spilled toner from the toner cartridge area and the toner cartridge cavity. 
 

  Cleaning Your Printer

  Maintaining the Toner Cartridge 

  Ordering Supplies

NOTE: Do not touch the transfer roller located under the toner cartridge when cleaning inside the printer. Oil from your fingers may cause print quality 
problems.

 CAUTION: Cleaning solvents that contain alcohol or other strong substances may discolor or crack the printer cabinet. 

 CAUTION: To prevent damage to the toner cartridge, do not expose the toner cartridge to light for more than a few minutes.

 CAUTION: Do not touch the green underside of the toner cartridge. Use the handle on the cartridge to avoid touching this area.



  
 

5. Reinsert the toner cartridge and close the front cover. 
 

6. Plug in the power cord and power the printer on.  

  

 

Maintaining the Toner Cartridge 

   

Storing the Toner Cartridge 

Store the toner cartridge in the original packaging until you are ready to install it. 

  

Do not store the toner cartridge in:  

  
l Temperatures greater than 40°C (104°F) 

 
   

l An environment with extreme changes in humidity or temperature 
 
   

l Direct sunlight 
 
   

l Dusty places 
 
   

l A car for a long period of time 
 
   

l An environment where corrosive gases are present 
 
   

l An environment with salty air 
 

  

Saving Toner 

  

To save toner, enable the Toner Save mode in the printer properties window. For details, see "Graphics Tab". Selecting this option will extend the life of the 
toner cartridge and reduce your cost per page, but will reduce print quality. 

  

Viewing Toner Levels  

  

You can check the level of toner remaining in the toner cartridge in the Printing Status window each time you send a print job to the printer. If you are having 
print quality problems, this can help you determine if the problem is caused by low toner. 

  

In the Printing Status window, you will see how much toner is remaining. 
 

 CAUTION: Do not touch the transfer roller inside the printer. Oil from your fingers may cause print quality problems.
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Redistributing Toner 

  

When the toner cartridge is near the end of its life, white streaks or light printing occur.  on the printer's operator panel lights orange. Thoroughly shake 
the toner cartridge from side-to-side 5 or 6 times to distribute the toner evenly and temporarily improve print quality. 

1. Open the front cover. 
 

  
 

2. Gently pull the toner cartridge out, being careful not to scratch against printer, and lift it up and away from the printer. Thoroughly shake the cartridge 5 
or 6 times to distribute the toner evenly inside the cartridge. 
 

  
 
 
 

3. Reinstall the cartridge and close the front cover. 
 

   

Replacing the Toner Cartridge 

  

When the toner eventually runs out, only blank pages print. At this stage, the toner cartridge needs to be replaced.  

  

Order an extra toner cartridge so you will have it on hand when the current cartridge no longer prints satisfactorily. See "Ordering Supplies" for information on 
ordering toner cartridges.  

  

To replace the toner cartridge: 

1. Open the front cover. 
 

NOTE: If toner comes into contact with your clothing, wipe the toner off with a dry cloth and wash your clothing in cold water. Hot water sets toner 
into fabric.

 CAUTION: Do not touch the green underside of the toner cartridge. Use the handle on the cartridge to avoid touching this area.

 CAUTION: For best results, use Dell toner cartridges. Print quality and printer reliability are not guaranteed if you do not use Dell supplies. 



  
 
 

2. Pull the used toner cartridge out and lift it up and away from the printer. 
 

  
 
 
 

3. Unpack a new toner cartridge. Hold the cartridge carefully and thoroughly shake it from side-to-side 5 or 6 times to distribute the toner. 
 

  

4. Pull the tape to remove the protective paper.  

  

    
 

5. Locate the cartridge slot inside the printer, one on each side.  

  
 

 CAUTION: Avoid reaching too far into the printer. The fusing area may be hot.

NOTE: If toner comes into contact with your clothing, wipe the toner off with a dry cloth and wash your clothing in cold water. Hot water sets 
toner into fabric.

 CAUTION: Do not touch the green underside of the toner cartridge. Use the handle on the cartridge to avoid touching this area.

 CAUTION: To prevent damage to the toner cartridge, do not expose it to light for more than a few minutes.



6. Unfold the toner cartridge handle and grasp it. Insert the cartridge into the printer until it snaps into place.  

  
 

7. Close the front cover. Make sure that the cover is securely closed. If it is not firmly closed, printing errors may occur.  

  

Ordering Supplies 

   

You can order supplies using the Dell™ Toner Management System or by contacting Dell at www.dell.com/supplies. 

   

In addition to the toner level indicator that is displayed in the Printing Status window each time you send a job to print, the printer's operator panel LED 
sequences tell you about the status of your supplies. When  lights orange, your toner cartridge is low and you should order a new toner cartridge. 

1. Double-click the Dell Toner Reorder Program icon on your desktop. 

 
 

OR 

From the Start menu, click Programs  Dell Printers  Dell Laser Printer 1110  Dell Toner Reorder Program. 

OR 

In the Printing Status window, click the Order Supplies button. 

2. The Order Toner Cartridges window appears. 

 

Click Visit Dell's cartridge ordering web site to order supplies online. 

If ordering by phone, call the number that appears under the By Telephone heading. 

  

  

  

  

  

http://www.dell.com/supplies


Paper Handling  

  

Print Media Guidelines 

Printer media includes paper, card stock, transparencies, labels, and envelopes. Your printer provides high quality printing on a variety of print media. Selecting 
the appropriate print media for your printer helps you avoid printing problems. To get the best possible print quality, use only high-quality, copier-grade paper. 

When you choose print materials, consider the followings: 

  
l Desired outcome: The paper you choose should be appropriate for the project. 

 
   

l Size: You can use any size paper that fits easily within the paper adjusters of the paper tray. 
 
   

l Weight: Your printer supports paper weights as follows: 
 

l 16~24 lbs (60~90 g/m2) bond for the paper tray  

 

l 16~43 lbs (60~163 g/m2) bond for manual feed mode  

 
   

l Brightness: Some papers are whiter than others and produces sharper, more vibrant images. 
 
   

l Surface smoothness: The smoothness of the paper affects how crisp the printing looks on the paper. 
 

  

Types, Input Modes, and Capacities 

a.  Maximum capacity may be reduced depending on the paper thickness. 
b.  If you load more than one sheet, paper jams will occur. You must load only one sheet at a time in the tray. 

  

Guidelines for Paper and Special Materials 

 When selecting or loading paper, envelopes, or other special material, keep these guidelines in mind: 

  
l Attempting to print on damp, curled, wrinkled, or torn paper can cause paper jams and poor print quality. 

 
   

l Use only high-quality, copier-grade paper for the best print quality.  
 
   

l Avoid paper with embossed lettering, perforations, or a texture that is too smooth or too rough. Paper jams may occur. 
 
   

l Store paper in its ream wrapper until you are ready to use it. Place cartons on pallets or shelves, not on the floor.  
 
   

l Do not place heavy objects on top of the paper, whether it is packaged or unpackaged.  
 
   

l Keep paper away from moisture, or other conditions that can cause it to wrinkle or curl. 
 
   

  Print Media Guidelines

  Verifying the Output Location

  Loading Print Media in the Paper Tray

  Using Manual Feed Mode 

  Printing on Special Materials 

 CAUTION: Using a material that does not conform to the specifications listed in "Paper Specifications" can cause problems that may 
require service. This service is not covered by the warranty or service agreements. 

Paper Type 
Input Mode/Capacitya 

Automatic Feed Manual Feed 

Plain Paper 150 1 

Envelopesb - 1 

Labelsb - 1 

Transparenciesb - 1 

Card Stockb - 1 
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l Store unused materials at temperatures between 15°C and 30oC (59°F to 86°F). The relative humidity should be between 10% and 70%. 
 
   

l During storage, you should use moisture-proof wrap, such as a plastic container or bag, to prevent dust and moisture from contaminating your paper. 
 
   

l Load special paper types one sheet at a time. 
 
   

l Only use materials specifically recommended for use with laser printers. 
 
   

l To prevent special materials, such as transparencies and label sheets, from sticking together, remove them as they print out. 
 
   

l For envelopes: 
 

l Use only well-constructed envelopes with sharp, well creased folds. 
 

l Do not use envelopes with clasps and snaps. 
 

l Do not use envelopes with windows, coated linings, self-adhesive seals, or other synthetic materials. 
 

l Do not use damaged or poorly made envelopes. 
 

l Use only envelopes recommended for laser printers. Before loading envelopes in the tray, make sure that they are undamaged and are not stuck 
together.  
 

l Do not feed stamped envelopes. 
 

   
l For transparencies: 

 
l Place them on a flat surface after removing them from the printer. 

 
l Do not leave them in the paper tray for long periods of time. Dust and dirt may accumulate on them, resulting in spotty printing. 

 
l To avoid smudging caused by fingerprints, handle them and coated paper carefully. 

 
l To avoid fading, do not expose printed transparencies to prolonged sunlight. 

 
l Use only transparencies recommended for use with laser printers. 

 
l Ensure that transparencies are not wrinkled, curled, or have any torn edges. 

 
l Do not use transparencies that are separating from the backing sheet. 

 
   

l For labels: 
 

l Verify that their adhesive material can tolerate fusing temperatures of 180°C (356°F) for 0.1 second. 
 

l Make sure that there is no exposed adhesive material between labels. Exposed areas can cause labels to peel off during printing, which can 
cause paper jams. Exposed adhesive can also cause damage to printer components. 
 

l Do not load a sheet of labels through the printer more than once. The adhesive backing is designed for one pass through the printer. 
 

l Do not use labels that are separating from the backing sheet or are wrinkled, bubbled, or otherwise damaged. 
 

l Use only labels recommended for laser printers. 
 

   
l For Card Stock or Custom-sized materials: 

 
l Postcards, 3.5 by 5.83 in.(index) cards and other custom-sized materials can be printed with this printer. The minimum size is 3.0 by 5.0 in.(76 by 

127 mm) and the maximum size is 8.5 by 14 in.(216 by 356 mm).  
 

l Always insert the short-edge into the Manual Feeder first. If you want to print in landscape mode, make this selection through your software. 
Inserting paper long-edge first may cause a paper jam. 
 

l Do not print on media smaller than 3.0 in.(76 mm) wide or 5.0 in.(127 mm) long. 
 

   
l For preprinted paper: 

 
l Letterheads must be printed with heat-resistant ink that will not melt, vaporize, or release hazardous emissions when subjected to the printer's 
fusing temperature of 205°C (400°F) for 0.1 second. 
 

l Ink on letterheads must be non-flammable and should not adversely affect printer rollers. 
 

l Forms and letterheads should be sealed in a moisture-proof wrapping to prevent changes during storage. 
 

l Before you load preprinted paper as forms and letterheads, verify that the ink on the paper is dry. During the fusing process, wet ink can come off 
preprinted paper. 
 

l Do not use Carbonless paper and Tracing paper. Use of these types of paper could result in chemical smells and could damage your printer.  
 

  

Verifying the Output Location 

  

The printer has a paper output tray that collects paper face-down, in print order.  



  

  

Loading Print Media in the Paper Tray 

  

Proper paper loading helps prevent paper jams and ensures trouble-free printing. Do not remove the paper in the tray while a job is printing. Doing so may 
cause a paper jam. See "Types, Input Modes, and Capacities" for acceptable paper size and capacity for the tray. You can load approximately 150 sheets of 
plain paper in the tray. 

  

Open the paper input tray and load the paper in the paper tray with the side to be printed on facing up.  

 

  

For details about loading paper in the tray, see "Loading Paper". 

  

Using Manual Feed Mode  

If you select Manual Feed in the Source option in your software application, you can manually load a sheet of print material in the tray. Manually loading print 
material can be helpful when you want to check the print quality after each page is printed. Use the manual feed mode to print transparencies, labels, 
envelopes, or postcards. 

  

To use the manual feed mode: 

1. Load a sheet of print material in the paper tray with the side to be printed on facing up. 
 
 

NOTE: If you print many pages, the surface of the output tray may become hot. Be careful not to touch the surface, and especially keep children away 
from the surface. 

NOTE: The output tray can hold up to 100 sheets of paper. Remove the pages so that the tray does not become overloaded.

NOTE: If you experience problems with paper feed, place a sheet of paper in the tray using the manual feed mode.

NOTE: Always load only the print materials specified in "Paper Specifications" to avoid paper jams and print quality problems. 

NOTE: Flatten any curl on postcards, envelopes, and labels before loading them into the tray.
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Adjust the paper length and width guides against the print material without bending it. 

2. To print a document in Manual Feed mode, you must select Manual Feed for Source from the software application, and then select the appropriate 
paper size and type. For details, see "Paper Tab". 
 

3. Press  on the printer's operator panel to start feeding. 

Printing starts.  
 

4. If you are printing multiple pages, load the next sheet after the first page prints out, and press . 

Repeat this step for every page to be printed.  

  

Printing on Special Materials  

1. Open the paper input tray. 
 

2. Load the print material in the paper input tray. Do not mix types. 
 

3. Adjust the length and width guides against the print material without bending it. 
 

4. To print on special material, you must select Manual Feed for Source from the software application, and then select the appropriate paper size and 
type. For details, see "Paper Tab". 
 

5. Press  to start. 

 

See the following directions to load each type of print material. 
 

l Load an envelope in the tray with the flap side down and the stamp area on the top left side. The end of the envelope with the stamp area enters 
the printer first, from the center of the tray. 
 
 

  
 

l Load a sheet of labels in the tray with the side to be printed on facing up. 
 
 

NOTE: If you don't press the button after a pause, the paper will be automatically fed into the printer. 

NOTICE: Never load envelopes with stamps, clasps, snaps, windows, coated linings, or self-stick adhesives. These envelopes may 
severely damage the printer. The stamp is shown in the illustration only for placement.

CAUTION: If you print 20 envelopes in succession, the surface of the top cover may become hot. Please exercise caution. 
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l Load a transparency in the tray with the side to be printed on facing up, and the top with the adhesive strip inserted first. 

 

  
 
 

 

 

 
l Load a sheet of card stock with the side to be printed on facing up, short edge first, from the center of the tray. 

 
 

  
 

 
l Load a letterhead in the tray with the design face up, top edge toward the printer. 

 
 

  
 
 

NOTE: To prevent labels from sticking to each other, do not let the printed label sheets stack up as they are printed out.

NOTE: To prevent transparencies from sticking to each other, do not let the printed sheets stack up as they are printed out.

NOTE: Place transparencies on a flat surface after removing them from the printer.

NOTE: Do not use transparencies that are separating from the backing sheet. 

NOTE: Do not print on media smaller than 3.0 in. (76 mm) wide or 5.0 in. (127 mm) long.

NOTE: Before you load letterhead, verify that the ink on the paper is dry. During the fusing process, wet ink can come off preprinted 
paper.



 



Printing  

   

  

Printing a Document 

 The driver provided with your printer allows a wide variety of options. The features provided by the printer driver are as follows: 

  

The following procedure describes the general steps required for printing from various Windows applications. The exact steps for printing a document may vary 
depending on the application program you are using. Refer to your software application's User's Guide for the exact printing procedure.  

1. Open the document you want to print. 
 

2. Select Print from the File menu.  

The Print window displays. It may look slightly different depending on your application.  

The basic print settings are selected within the Print window. These settings include the number of copies and the print range. 
 

 
 

3. To take advantage of the printer features provided by your printer, click Preferences or Properties depending on the program or operating system in 
the print window and go to step 4.  

If you see Setup, Printer, or Options, click that button instead. Then click Properties on the next screen. 

4. Click OK to close the printer properties window.  
 

5. To start the print job, click Print or OK, depending on the program or operating system in the Print window.  

   

Canceling a Print Job 

 There are two ways to cancel a print job: 

 

To stop a print job from the operator panel: 

  

   Printing a Document    Fitting Your Document to a Selected Paper Size

   Printer Settings    Printing a Reduced or Enlarged 
Document

   Printing Multiple Pages on One Sheet of Paper    Using Watermarks 

  Printing Posters    Using Overlays

   Printing on Both Sides of Paper (Manual Duplex)    Setting Up a Locally Shared 
Printer

 

Feature 
Printer Driver 

Windows 98/Me/2000/XP 

Toner Save Y 

Print Quality Option Y 

Poster Printing Y 

Multiple Pages per Sheet (N-up) Y 

Fit to Page Printing Y 

Scale Printing Y 

Watermark Y 

Overlay Y 



Press . In Manual Feed mode, you can't cancel a print job by pressing .  

 

  

  

Your printer finishes printing the page that is moving through the printer and deletes the rest of the print job. Pressing  cancels only the current job. If more 

than one print job is in the printer's memory, you need to press  once for each job. 

 

To stop a print job from the Printers folder: 

1. From the Windows Start button, click Settings. 
 

2. Select to Printers (Windows 98/Me/2000) or Printers and Faxes (Windows XP) to open the Printers window and double-click the Dell Laser Printer 
1110 icon.  
 

3. From the Document menu, click Cancel (Windows 2000/XP) or Cancel Printing (Windows 98/Me).
 
 

 

  

Printer Settings 

 You can use the printer properties window, which allows you to access all of the printer options you may need when using your printer. When the printer 
properties are displayed, you can review and change any settings needed for your print job.  

 The printer properties window may differ, depending on your operating system. The User's Guide shows the Printing Preferences window for Windows XP. 

 If you access printer properties through the Printers folder, you can view additional Windows-based tabs (refer to your Windows User's Guide) and the Printer 
tab (see "Printer Tab"). 

a.  Click the Windows Start button.  
 

b.  For Windows 98/Me/2000, click Settings and point to Printers. 
 
For Windows XP, click Printers and Faxes. 

c.  Point to the Dell Laser Printer 1110 icon. 
 

d.  Right-click on the printer icon and:  
 

l  For Windows 98/Me, click Properties. 
 

l  For Windows 2000/XP, click Print Setup or click Properties and point to Printing Preferences. 
 

e.   Change the settings on each tab and click OK. 
 

  

Layout Tab 

NOTE: You can access this window simply by double-clicking the printer icon at the bottom right corner of the Windows desktop.

NOTE: Most Windows applications override settings you specify in the printer driver. Change all of the print settings available in the software 
application first, and change any remaining settings using the printer driver. 

NOTE: The settings you change remain in effect only while you are using the current program. To make your changes permanent, make them in the 
Printers folder. Follow these steps:



 The Layout tab provides options for you to adjust how the document appears on the printed page. The Layout Options section includes advanced printing 
options, such as Multiple Pages per Side and Poster. See step 3 in "Printing a Document" for more information on accessing printer properties.  

 

  

Paper Tab 

 Use the following options to set paper handling needs when you access printer properties. See step 3 in "Printing a Document" for more information about 
accessing printer properties. Click the Paper tab to access paper properties.  

 

Property Description 

 Orientation Orientation allows you to select the direction in which information is printed on a page. 

If you want to rotate the page 180-degrees, select 180 from the Rotate drop-down list. 

  

• Portrait prints across the width of the page, letter style.

• Landscape prints across the length of the page, spreadsheet style.

 Layout Options Layout Options allows you to select advanced printing options. For details, see "Printing Multiple Pages on One Sheet of Paper"and 
"Printing Posters". 

 Double-sided 
Printing

Double-sided Printing allows you to print two-sided jobs manually. For details, see "Printing on Both Sides of Paper (Manual 
Duplex)". 

Property Description 

 Copies Copies allows you to choose the number of copies to be printed. You can enter up to 999. 

 Size The Size option allows you to choose the size of paper loaded in the paper tray.  

If the required size is not listed in the Size box, click Custom. When the Custom Page Size window appears, set the paper size and 
click OK. The setting appears on the list so that you can select it.  



  

Graphics Tab 

  

Use the following graphic options to adjust the print quality for your specific printing needs. See step 3 in "Printing a Document" for more information about 
accessing printer properties. Click the Graphics tab to display the properties shown below.  

  

  

 Source Make sure that Source is set to the appropriate paper input mode. 

The Manual Feed source is used when printing on special materials. You need to load one sheet at a time into the paper tray. See 
"Using Manual Feed Mode". 

If the paper source is set to Auto Select, the printer automatically picks up print materials from the paper tray. 

 Type Make sure that Type is set to Printer Default. If you load a different type of print material, select the corresponding paper type. For 
more information about print materials, refer to "Paper Handling". 

If you are using cotton paper, set the paper type to Thick for the best results. 

If you are using recycled paper or color paper, select Color Paper. 

 Scaling Scaling allows you to automatically or manually scale your print job on a page. You can choose from None, Fit to Page, and 
Reduce/Enlarge. 

For details, see "Fitting Your Document to a Selected Paper Size" and "Printing a Reduced or Enlarged Document". 

Property Description 

 Resolution You can select the printing resolution by choosing from 600 dpi [Normal] or 300 dpi [Draft]. The higher the 
setting, the sharper the clarity of printed characters and graphics. Higher settings may increase the time it takes 
to print a document.

 Toner Save Mode Selecting this option extends the life of your toner cartridge and reduces your cost per page without a 
significant reduction in print quality. 

• On: Select this option to allow the printer to use less toner on each page.

• Off: If you don't need to save toner when printing, select this option.

 Darkness Use this option to lighten or darken your print job. 

• Normal: This setting is for normal documents.

• Light: This setting is for documents with bolder line widths or darker gray-scale images.

• Dark: This setting is for documents with finer line widths, higher definition graphics, and lighter gray-scale 
images.

file:///C:/data/CHM_OUT/systems/prn1110/en/ug/ug_en.chm/ug_en/paper.html#1026531
file:///C:/data/CHM_OUT/systems/prn1110/en/ug/ug_en.chm/ug_en/paper.html#1031885


  

Extras Tab 

 See step 3 in "Printing a Document" for more information about accessing printer properties. Click the Extras tab to access the following features: 

  

  

About Tab 

 Use the About tab to display the copyright notice and the version number of the driver. If you have an Internet browser, you can connect to the Internet by 
clicking DellWebsite. See step 3 in "Printing a Document" for more information about accessing printer properties. 

  

Printer Tab 

 Advanced Options You can set advanced settings by clicking the Advanced Options button.  

  

TrueType Options  

This option determines what the driver tells the printer about how to print the text in your document. Select the appropriate 
setting according to the status of your document. This option is available only when you use Windows 98. 

Print All Text Black 

When the Print All Text Black option is checked, all text in your document is printed in solid black, regardless of the color it 
appears on the screen. When it is not checked, colored text is printed in shades of gray. 

Darken Text 

When the Darken Text option is checked, all text in your document is printed darker than on a normal document. 

• Download as Bit Image: When this option is selected, the driver downloads the font data as bitmap images. 
Documents with complicated fonts, such as Korean or Chinese, or various other fonts, will print faster in this setting.

• Print as Graphics: When this option is selected, the driver downloads all fonts as graphics. When printing documents with high 
graphic content and relatively few TrueType fonts, printing performance (speed) may be enhanced in this setting.

Property Description 

 Watermark You can add text to be printed across each page of your document. See "Using Watermarks".  

 Overlay Overlays are often used to take the place of preprinted forms and letterhead paper. See "Using Overlays". 

 Output Options Print Order: You can set the sequence for the pages to print. Select the print order from the drop-down list. 

Reprint When Jammed: When this option is checked, the printer retains the image of a printed page until the printer signals that 
the page has successfully exited the printer. If a paper jam occurs, the printer will reprint the last page sent from the computer after 
you have cleared the jam. 

• Normal: Your printer prints all pages from the first page to the last page.

• Reverse All Pages: Your printer prints all pages from the last page to the first page.

• Print Odd Pages: Your printer prints only the odd pages of the document.

• Print Even Pages: Your printer prints only the even pages of the document.

NOTE: When a paper jam occurs in the paper exit area, your printer will not reprint failed pages. Reprint the failed pages.



 If you access printer properties through the Printers folder, you can view the Printer tab. You can adjust the printer configuration. 

1. Click the Windows Start menu. 
 

2. For Windows 98/Me/2000, select Settings and then Printer. 

For Windows XP, select Printers and Faxes. 

3. Select the Dell Laser Printer 1110 icon. 
 

4. Right-click on the printer icon and select Properties. 
 

5. Click the Printer tab and set the options. 
 
 

 

 
 

Using a Favorite Setting 

 The Favorites option, which is visible on each properties tab, except for the About tab, allows you to save the current properties settings for future use.  

 To save a Favorites item: 

1. Change the settings on each tab, as needed.  
 

2. Enter a name for the item in the Favorites input box. 
 

  
 
 

3. Click Save. 

  

To use a saved setting, select it from the Favorites drop-down list.  

  

To delete a favorite setting item, select it from the list and click Delete.  

  

Property Description 

 High Altitude 
Correction

If your printer is going to be used at an altitude above 2,500 m (8,200 ft), checking this option will optimize the print quality for 
those circumstances.  

 Power Save When this option is checked, the printer switches to power save mode after the specified time has elapsed since its last activity. 
You can select the length of time before your printer goes into power save mode from the Time Delay drop-down list. The 
minimum time you can select is 5 Minutes. 

 Display Printing 
Status Window

When this option is checked, the Printing Status window, which shows the status of your printer, displays on the computer screen 
each time you send a print job to the printer. 



You can also restore the printer driver's default settings by selecting Printer Default from the list.  

  

Using Help 

  

Your printer has a help screen that can be activated by the Help button in the printer's properties window. These help screens give detailed information about 
the printer features provided by the printer driver. 

  

You can also click  from the upper right hand corner, and then click on any setting.  

 

Printing Multiple Pages on One Sheet of Paper 

 

  
 
 

4. If necessary, select the page order from the Page Order drop-down list.  
 
 

 
 

Check Print Page Border to print a border around each page on the sheet. Print Page Border or Page Order is enabled only if the Pages per Side 
setting is set to a number greater than one. 

5. Click the Paper tab and select the paper source, size, and type. 
 

6. Click OK and print the document.  

  

Printing Posters 

  You can select the number of pages to be printed on a single sheet of paper. To print more than one page per sheet, the pages will be 
decreased in size and arranged on the sheet. You can print up to 16 pages on one sheet. 

1. To change the print settings from your software application, access printer properties. See step 3 in "Printing a Document". 
 

2. From the Layout tab, choose Multiple Pages per Side from the Type drop-down list.  
 

3. Select the number of pages you want to print per sheet (1, 2, 4, 6, 9, or 16) from the Pages per Side drop-down list.  

 You can print a single-page document onto 4, 9, or 16 sheets of paper, for the purpose of pasting the sheets together to form one poster-
sized document. 

1. To change the print settings from your software application, access printer properties. See step 3 in "Printing a Document". 
 

2. From the Layout tab, select Poster from the Type drop-down list.  
 



  
 

3. Configure the poster option: 
 
You can select the page layout from 2x2, 3x3, or 4x4. If you select 2x2, the output will be automatically stretched to cover 
4 physical pages. 
 
 

  
 
 

Specify an overlap in millimeters or inches to make it easier to reconstruct the resulting poster.  
 
 

  
 

4. Click the Paper tab and select the paper source, size, and type. 
 

5. Click OK and print the document. You can complete the poster by pasting together the resulting pages  

  

Printing on Both Sides of Paper (Manual Duplex) 

 

 

  

  

To manually print a 2-sided document: 

You can print on both sides of a sheet of paper manually. Before printing, decide how you want your document oriented. 

  

The options are: 

  
l Long Edge, which is the conventional layout used in book binding. 

 
   

l Short Edge, which is the type often used with calendars.  
 

NOTE: Do not print on both sides of labels, transparencies, envelopes, or thick paper. Paper jamming and damage to the printer may result. 

NOTE: To use double-sided printing, you can use only the following paper sizes: A4, Letter, Legal, and Folio, with a weight of 20~24 lbs (75~90 g/m2). 



1. To change the print settings from your software application, access printer properties. See step 3 in "Printing a Document". 
 

2. From the Layout tab, select the paper orientation. 
 

3. From the Double-sided Printing section, select either None, Long Edge, or Short Edge.  
 
 

 
 

4. Click the Paper tab and select the paper source, size, and type. 
 

5. Click OK and print the document.  
 
 
The printer prints every other page of the document first. Once the first side of your job has printed, the following window appears and  blinks red. 
 
 
 

  
 

6. Load the paper back into the printer with the already-printed side down and the top of the page toward the front of the tray according to the 
instructions in the above window. 
 

7. Press  to print the other side of your job.  

  

Fitting Your Document to a Selected Paper Size 

You can scale your print job to any selected paper size, regardless of the digital document size. This can be useful when you want to check 
fine details on a small document.  

1. To change the print settings from your software application, access printer properties. See step 3 in "Printing a Document". 
 

2. From the Paper tab, select Fit to Page from the Type drop-down list.  
 

3. Select the size that you want from the Target Page drop-down list.  
 

 
 

4. Select the paper source, size, and type in Paper Options. 
 

5. Click OK and print the document.  



  

Printing a Reduced or Enlarged Document  

  

Using Watermarks 

Using an Existing Watermark 

1. To change the print settings from your software application, access printer properties. See step 3 in "Printing a Document".  
 

2. Click the Extras tab and select a watermark from the Watermark drop-down list. It appears in the preview image window.  
 

 
 

3. Click OK and start printing.  
 

  

You can scale your print job on a page.  

1. To change the print settings from your software application, access printer properties. See step 3 in "Printing a Document".  
 

2. From the Paper tab, select Reduce/Enlarge from the Type drop-down list.  
 

3. Enter the scaling rate in the Percentage input box.  
 
You can also click the  or  button. 
 

  

4. Select the paper source, size, and type in Paper Options.  
 

5. Click OK and print the document.  

  

 The Watermark option allows you to print text over an existing document. For example, you may want to have large gray letters reading 
"DRAFT" or "CONFIDENTIAL" printed diagonally across the first page or all pages of a document.  

  

There are several predefined watermarks that come with your printer, and they can be modified or you can add new ones to the list. 

  

NOTE: The preview image shows how the page will look when it is printed. 



Creating a Watermark 

1. To change the print settings from your software application, access printer properties. See step 3 in "Printing a Document".  
 

2. Click the Extras tab and click Edit in the Watermark section. The Edit Watermark window appears.  
 

  
 
 

3. Enter the text message you want to have printed in the Watermark Message box.  

The message displays in the preview image window. The preview image is provided so that you can see how the watermark will appear on the printed 
page. 

When the First Page Only box is checked, the watermark is printed on the first page only. 

4. Select the watermark options.  

You can select the font name, style, size, and gray scale level from the Font Attributes section and set the angle of the watermark from the Message 
Angle section.  

5. Click Add to add a new watermark to the list.  
 

6. When you have finished, click OK and start printing.  

  

To stop printing the watermark, select [No Watermark] from the Watermark drop-down list.  

  

Editing a Watermark 

1. To change the print settings from your software application, access printer properties. See step 3 in "Printing a Document".  
 

2. Click the Extras tab and click Edit in the Watermark section. The Edit Watermark window appears. 
 

3. Select the watermark you want to edit from the Current Watermarks list, and change the watermark message and the options. 
 

4. Click Update to save the changes. 
 

5. Click OK.  
 

   

Deleting a Watermark 

1. To change the print settings from your software application, access printer properties. See step 3 in "Printing a Document". 
 

2. From the Extras tab, click Edit in the Watermark section. The Edit Watermark window appears. 
 

3. Select the watermark you want to delete from the Current Watermarks list and click Delete.  
 

4. Click OK. 
 
 

Using Overlays 

What is an Overlay? 

 An overlay is text and/or images stored in the computer hard disk drive (HDD) as a special file format that can be printed on any document. 
Overlays are often used to take the place of preprinted forms and letterhead paper. Rather than using preprinted letterhead, you can create 
an overlay containing the exact same information that is currently on your letterhead. To print a letter with your company's letterhead, you 
do not need to load preprinted letterhead paper in the printer. You need only tell the printer to print the letterhead overlay on your 
document. 



Creating a New Page Overlay 

 
 

4. In the Edit Overlay window, click Create Overlay.  
 

 
 

5. In the Create Overlay window, type a name of up to eight characters in the File name box. Select the destination path, if necessary. (The default is 
C:\Formover).  
 

 
 

6. Click Save. You can see the name in the Overlay List.  
 

7. Click OK or Yes until you have finished.  

The file is not printed; it is stored in your computer.  

  

Using a Page Overlay 

  

After an overlay has been created, it is ready to be printed with your document. To print an overlay with a document: 

1. Create or open the document you want to print.  
 

2. To change the print settings from your software application, access printer properties. See step 3 in "Printing a Document".  
 

3. Click the Extras tab.  
 

4. Select the overlay you want to print from the Overlay drop-down list box.  
 

5. If the overlay file doesn't appear on the Overlay list, click Edit and then Load Overlay, and select the overlay file.  
 
 

To use a page overlay, you must create a new page overlay containing your logo or image. 

1. Create or open a document containing text or an image for use in a new page overlay. Position the items exactly as you wish them to 
appear when printed as an overlay. If needed, save the file for later use. 
 

2. To change the print settings from your software application, access printer properties. See step 3 in "Printing a Document". 
 

3. Click the Extras tab and click Edit in the Overlay section.  
 



  
 

If you have stored the overlay file you want to use on an external source, such as a CD or floppy disk, you can also load the file from that source when 
you access this Load Overlay window.  

After you select the file, click Open. The file is now shown in the Overlay List box and is available for printing. Select the overlay from the Overlay List 
box.  

  

6. If necessary, select Confirm Page Overlay When Printing checkbox. When this box is checked, a message window appears each time you submit a 
document for printing, asking you to confirm that you want to print an overlay on your document.  

Answering Yes to the window means that the selected overlay will be printed with your document. Answering No to the window cancels the use of the 
overlay page.  

If this box is empty and an overlay has been selected, the overlay will be printed automatically with your document.  

7. Click OK or Yes until printing starts.  
 

The overlay is downloaded with your print job and printed on your document.  

  

Deleting a Page Overlay 

 You can delete page overlays that are no longer used.  

1. In the printer properties window, click the Extras tab.  
 

2. Click Edit in the Overlay section.  
 

3. Select the overlay you want to delete from the Overlay List box.  
 

4. Click Delete Overlay.  
 

5. When a confirmation message window appears, click Yes. 
 

6. Click OK until you exit the Print window.  

  

  

Setting Up a Locally Shared Printer  

You can connect the printer directly to a selected computer, called the "host computer," on a network using a USB cable. Your printer can be shared by other 
users on the network through a Windows 98, Me, 2000, or XP network printer connection. Before you can share your printer, you must first set up a Microsoft 
Windows network. 

  

In Windows 98/Me 

Setting Up the Host Computer 

1. Start Windows. 
 

2. Click the Start button, select Control Panel, and double-click the Network icon. 
 

3. Click the File and Print Sharing box, check the box next to I want to be able to allow others to print to my printer, and click OK. 
 

4. Click Start and select Printers from Settings. Double-click your printer name. 



 
5. Click Properties in the Printer menu. 

 
6. Click the Sharing tab and check the Shared As box. Fill in the Share Name field and then click OK. 

 
 

Setting Up the Client Computer 

1. Right-click the Start button and select Explore.  
 

2. Open your network folder in the left column.  
 

3. Right-click the shared name and click Capture Printer Port.  
 

4. Select the port you want, check the Reconnect at log on box, and then click OK. 
 

5. Click the Start button and select Settings and then Printers. 
 

6. Double-click your printer icon. 
 

7. Click the Printer menu and point to Properties. 
 

8. Click the Details tab, select the printer port, and then click OK.  

   

In Windows 2000/XP 

Setting Up the Host Computer 

1. Start Windows.  
 

2. For Windows 2000, click the Start button  Settings  Printers.  

For Windows XP, click the Start button and select Printers and Faxes.  

3. Double-click your printer icon.  
 

4. Click the Printer menu and select Sharing.  
 

5. For Windows 2000, check the Shared As box.  

For Windows XP, check the Share this printer box.  

6. Fill in the Share Name field and click OK.  
 
 

Setting Up the Client Computer 

1. Right-click the Start button and select Explore.  
 

2. Open your network folder in the left column.  
 

3. Click the shared name. If you can't find the shared name, make sure that the user account for the client computer is registered on the host computer.  
 

4. For Windows 2000, from the Start button, click Settings and select Printers.  

For Windows XP, from the Start button, click and select Printers and Faxes. 

5. Double-click your printer icon.  
 

6. Click the Printer menu and select Properties.  
 

7. Click the Ports tab and select Add Port.  
 

8. Click Local Port and select New Port.  
 

9. Fill in the Enter a port name field and enter the shared name.  
 

10. Click OK and select Close.  
 

11. Click Apply and select OK. 
 

 



Software Overview  

After setting up your printer and connecting it to your computer, you must install the drivers and utilities from the Drivers and Utilities CD included with your 
printer. If you purchased a Dell™ computer and your printer at the same time, the drivers and utilities are automatically installed. You don't need to install 
them. The Drivers and Utilities CD contains the following: 

  
l Dell Printer Driver– allows your computer to communicate with your printer. To use your printer as a printer in Windows, you must install the printer 

driver. For information about installing the printer driver in Windows, see "Installing Software". 
 
   

l Dell Toner Management System™ – displays the status of the printer and the name of the job when you send a job to print. The Dell Toner Management 
System™ window also displays the level of toner remaining and allows you to order replacement toner cartridges.  
 
   

l User's Guide– HTML documentation provides detailed information about using your printer. 
 

  

Installing Software  

Before you begin, ensure that your system meets the minimum requirements. 

 

System Requirements 

  

Installing Dell Software 

  

A printer driver is software that lets your computer communicate with your printer. The procedure to install drivers depends on the operating system you are 
using. 

1. Make sure that the printer is connected to your computer and powered on. Close all unnecessary programs.  
 

 

2. Insert the Drivers and Utilities CD. 
 

  
 
 

3. If necessary, select a language by pressing the Language button on the main screen. 
 

4. Select Typical Installation to install the User's Guide, the printer driver, and Dell Toner Management System™ as the default settings. 
 

NOTE: For Windows 2000/XP, the system administrator should install Dell software. 

Item Requirements 

Operating System Windows 98/Me/2000/XP 

CPU Windows 98/Me/2000 Pentium II 400 Mhz or higher

Windows XP Pentium III 933 Mhz or higher

RAM Windows 98/Me/2000 64 MB or higher

Windows XP 128 MB or higher

Free Disk Space Windows 98/Me/2000 300 MB or higher

Windows XP 1 GB or higher

Internet Explorer 5.0 or higher 

NOTE: If you attach a USB printer cable while your printer and computer are powered on, the Windows hardware wizard launches immediately. Cancel 
the screen and use the Drivers and Utilities CD to install the Dell software.

NOTE: If the printer is not connected to your computer when you install the CD-ROM, the No Printer Found screen appears. Follow the 
instructions to install the software.



To choose an individual component to install, select Custom Installation. You can also change the destination folder.  

5. When the installation has been completed, you may print a test page. Click Finish to complete the installation and close the wizard. You are now ready 
to print. 
 

  

Uninstalling Software  

You should remove the printer driver if you are upgrading the software or if your driver installation fails. You can remove the software using the Drivers and 
Utilities CD or the Windows uninstall. 

1. From the Start menu, select Programs  Dell Printers  Dell Laser Printer 1110  Dell Printer Software uninstall.  
 

  
 
 

2. Select the software you want to remove and click Next. 
 
The selected driver and all of its components are removed from your computer.  

3. Click Finish. 
 

  

Using the Dell™ Toner Management System 

  

Printing Status Window 

The Printing Status window displays the status of the printer (Printer Ready, Printer Offline, and Error-Check Printer), the name of the job currently being 
printed, and the toner level for your printer.  

 The Printing Status window launches when you send a print job to the printer. This appears only on the computer screen.  
 

  

Dell Toner Reorder Program 

The Dell Toner Reorder Program window can be launched from the Printing Status window, the Programs window, or the desktop icon. 

You can order toner by phone or from the Web. For details, see "Ordering Supplies". 

  

  

NOTE: Close all programs before uninstalling software.
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Specifications  

   

  

Printer Specifications 

 

  

Paper Specifications 

 

Overview 

  

Your printer accepts a variety of print materials, such as cut-sheet paper (including up to 100 percent recycled-fiber content paper), envelopes, labels, 
transparencies, and custom-sized paper. Properties, such as weight, composition, grain, and moisture content, are important factors affecting the printer's 
performance and the output quality. Paper that does not meet the guidelines outlined in this User's Guide can cause the following problems: 

  
l Poor print quality 

 
   

l Increased paper jams 
 
   

l Premature wear on the printer 
 

  

  Printer Specifications 

  Paper Specifications 

Item Specifications and Description 

Print Speed Up to 16 ppm in A4 (17 ppm in Letter) 

Resolution 600 x 600 dpi 

First Printing Time 10 seconds 

Warm-up Time 30 seconds 

Power Rating AC 110~127 V (USA, Canada) / 220~240 V (Others), 50 / 60 Hz 

Power Consumption 300 W average during operation / Less than 6 W in sleep mode 

Acoustic Noise Stand by: Less than 30 dB; 
Printing: Less than 50 dB; 
Sleep mode: Background noise 

Toner Supply Single cartridge 

Toner Cartridge Life Ships with 1,000-page starter toner cartridge at ISO 19752 5% coverage (2,000 pages for a standard toner cartridge) 

Duty Cycle Monthly: Up to 8,000 pages 

Weight 5.5 Kg (including Toner Cartridge) 

Package Weight Paper: 1.2 Kg 
Plastic: 0.2 Kg 

External Dimensions 
(W x D x H) 

358 x 299 x 217 mm / 14.1 x 11.8 x 8.5 in. 

Operating Environment Temperature:10~32°C / 50~90°F; Humidity: 20~80% RH 

Emulation GDI 

Random Access Memory (RAM) 2 MB (non expandable) 

Fonts Windows fonts 

Interface USB 1.1 (Compatible with USB 2.0) 

OS Compatibility Windows 98/Me/2000/XP 

NOTE: Some paper may meet all of the guidelines in this guide and still not produce satisfactory results. This may be the result of improper handling, 
unacceptable temperature and humidity levels, or other variables over which Dell has no control.

NOTE: Before purchasing large quantities of paper, insure the paper meets the requirements specified in this User's Guide.

 CAUTION: Using paper that does not meet these specifications may cause problems, requiring repairs. These repairs are not covered by the Dell 
warranty or service agreements. 



Supported Sizes of Paper  

a.  The printer supports a wide range of media sizes.  
b.  Capacity may vary depending on print materials' weight and thickness, and environmental conditions.  

  

  

Guidelines for Using Paper 

 For best results, use conventional 75 g/m² (20 lb) paper. Ensure that the paper is of good quality, and free of cuts, nicks, tears, spots, loose particles, dust, 
wrinkles, voids, and curled or bent edges. 

  

If you are unsure of what type of paper you are loading, such as bond or recycled paper, check the label on the package. 

Paper Dimensionsa Weight Capacityb 

Plain Paper 

Letter 

  

8.5 x 11 in. 
(216 x 279 mm) 

  

• 60 to 90 g/m²ond  
(16 to 24 lb) for the paper tray

• 60 to 163 g/m² bond(16 to 43 lb) for  
manual feed mode 

• 150 sheets of 75 g/m² bond (20 lb) 
paper for the paper tray

• 1 sheet of paper for manual feed mode 

A4 8.27 x 11.7 in. 
(210 x 297 mm) 

A5 5.83 x 8.27 in. 
(148 x 210 mm) 

Executive 7.25 x 10.5 in. 
(184.2 x 266.7 mm) 

Legal 8.5 x 14 in. 
(215.9 x 355.6 mm) 

JIS B5 7.17 x 10.1 in. 
(182 x 257 mm) 

ISO B5 6.93 x 9.84 in. 
(176 x 250 mm) 

A6 4.13 x 5.85 in. 
(105 x 148.5 mm) 

Oficio 8.50 x 13.50 in. 
(216 x 343 mm)

US Folio 8.5 x 13 in. 
(216 x 330 mm) 

Envelopes 

No.10 

  

4.12 x 9.5 in. 
(105 x 241mm) 

75 to 90 g/m² bond  
(20 to 24 lb) for  
manual feed mode 

1 sheet of paper for manual feed mode 

DL 4.33 x 8.66 in. 
(110 x 220 mm) 

C5 6.38 x 9.01 in. 
(162 x 229 mm) 

C6 4.5 x 6.4in. 
(114 x 162 mm) 

Monarch 3.875 x 7.5in. 
(98.4 x 190.5 mm) 

Labels 

Letter 

  

8.5 x 11 in. 
(216 x 279 mm) 120 to 150 g/m² bond 

A4 8.3 x 11.7 in. 
(210 x 297 mm) 

Transparencies 

Letter 

  

8.5 x 11 in. 
(216 x 279 mm) 

138 to 146 g/m² bond 

A4 8.3 x 11.7 in. 
(210 x 297 mm) 

Card Stocks 

Post Card 

  

4 x 6 in. 
(101.6 x 152.4 mm) 

90 to 163 g/m² bond  
(16 to 43 lb) for manual feed mode 

Minimum Size (custom) 3 x 5 in. 
(76 x 127 mm) 60 to 120 g/m² bond 

(16 to 32 lb) for manual feed mode Maximum Size (Legal) 8.5 x 14 in. 
(216 x 356 mm) 

NOTE: You may experience jams when using print materials with a length of less than 127 mm (5 inches). For optimum performance, ensure that you 
are storing and handling the paper correctly. Please refer to "Printer and Paper Storage Environment".



  

The following problems may cause print quality deviations, jamming, or even damage to the printer: 
 

  

Paper Specifications  

  

Paper Output Capacity  

   

Printer and Paper Storage Environment 

 Paper storage conditions directly affect the feed operation. 

 Ideally, the printer and paper storage environment should be at or near room temperature, and not too dry or humid. Remember that paper is hygroscopic: it 
absorbs and loses moisture rapidly.  

 Heat works with humidity to damage paper. Heat causes the moisture in paper to evaporate, while cold causes it to condense on the sheets. Heating 
systems and air conditioners remove most of the humidity from a room. As paper is opened and used, it loses moisture, causing streaks and smudging. Humid 
weather or water coolers can cause the humidity to increase in a room. As paper is opened and used it absorbs any excess moisture, causing light print and 
dropouts. Also, as paper loses and gains moisture it can become distorted. This can cause paper jams.

 Care should be taken not to purchase more paper than can be used in a short time (about 3 months). Paper stored for long periods may experience heat and 
moisture extremes, which can cause damage. Planning is important to prevent damage to large supplies of paper. 

  

Unopened paper in sealed reams can remain stable for several months before use. Opened packages of paper have more potential for environment damage, 
especially if they are not wrapped with a moisture-proof barrier. 

  

The paper storage environment should be properly maintained to ensure optimum performance. The required condition is 20°C to 24°C (68°F to 75°F), with a 
relative humidity of 4 percent to 55 percent. The following guidelines should be considered when evaluating the paper's storage environment: 

  
l Paper should be stored at or near room temperature. 

 
   

l The air should not be too dry or too humid. 
 
   

Symptom Problem with Paper Solution 

Poor print quality or toner adhesion, problems 
with feeding 

Too moist, too rough, too smooth, or embossed; 
faulty paper lot 

Try another kind of paper, between 100-400 
Sheffield, 4%~5% moisture content. 

Dropout, jamming, curl Stored improperly Store paper flat in its moisture-proof wrapping. 

Increased gray background shading/printer 
wear 

Too heavy Use lighter paper; use the rear output slot. 

Excessive curl problems with feeding Too moist, wrong grain direction, or short-grain 
construction 

• Use the rear output slot.

• Use long-grain paper.

Jamming, damage to printer Cutouts or perforations Do not use paper with cutouts or perforations. 

Problems with feeding Ragged edges Use good quality paper. 

NOTE: Do not use letterhead paper printed with low-temperature inks, such as those used in some types of thermography.

NOTE: Do not use raised or embossed letterhead.

NOTE: The printer uses heat and pressure to fuse toner to the paper. Insure that any colored paper or preprinted forms use inks that are compatible 
with this fusing temperature (200°C or 392°F for 0.1 second).

Category Specifications 

Acid Content 5.5~8.0 pH 

Caliper 0.094~0.18 mm (3.0~7.0 mils) 

Curl in Ream Flat within 0.02 in (5 mm) 

Cut Edge Conditions Cut with sharp blades with no visible fray. 

Fusing Compatibility Must not scorch, melt, offset, or release hazardous emissions when heated to 200°C (392°F) for 0.1 second. 

Grain Long Grain 

Moisture Content 4%~6% by weight 

Smoothness 100~250 Sheffield 

Output Location Capacity 

Paper Output Tray (Face Down) 100 sheets of 75 g/m² bond (20 lb) paper 



l The best way to store an opened ream of paper is to rewrap it tightly in its moisture-proof wrapping. If the printer environment is subject to extremes, 
unwrap only the amount of paper to be used during the day's operation to prevent unwanted moisture changes. 
 

  



Dell™ Laser Printer 1110 User's Guide 

  

Click the links to the left for information on the features, options, and operation of your printer. For information on other documentation included with your 
printer, see "Finding Information". 

  

To order replacement toner cartridges or supplies from Dell: 

1. Double-click the Dell Toner Reorder Program icon on your desktop.
 
 

  
 
OR  

2. Visit Dell's website, or order Dell printer supplies by phone. 
 

www.dell.com/supplies 

  

Notes, Notices, and Cautions 

  

  

 NOTE: A NOTE indicates important information that helps you make better use of your printer.

 
NOTICE: A NOTICE indicates either potential damage to hardware or loss of data and tells you how to avoid the problem.

 CAUTION: A CAUTION indicates a potential for property damage, personal injury, or death. 

----------------------------------------------------------------- 

Information in this document is subject to change without notice.  
© 2005 Dell Inc.. All rights reserved.  

  

Reproduction in any manner whatsoever without the written permission of Dell Inc. is strictly forbidden. 

  

Trademarks used in this text: Dell, DELL logo, and Dell Toner Management System are trademarks of Dell 
Inc.; Microsoft and Windows are registered trademarks of Microsoft Corporation.  

  

Adobe is a registered trademark of Adobe Systems Incorporated. 

  

Other trademarks and trade names may be used in this document to refer to either the entities claiming 
the marks or the names of their products. Dell Inc. disclaims any proprietary interest in trademarks and 
trade names other than its own. 

----------------------------------------------------------------- 

Model Dell 1110 
Mar 2006           SRV XG041           Rev. A00
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Troubleshooting  

  

  

Clearing Jams in the Paper Tray  

Occasionally, paper jams during a print job. Some causes could be: 

  
l The tray is overfilled. 

 
   

l The front cover or top cover has been opened during a print job. 
 
   

l The adjustable paper guides are not properly positioned. 
 
   

l Paper that does not meet paper specifications has been used. See "Paper Specifications". 
 
   

l Paper that is outside of the supported size range has been used. See "Paper Specifications". 
 

  

If a paper jam occurs,  on the operator panel lights red. Find and remove the jammed paper. If you cannot see it, look inside the printer.  

To avoid tearing the paper, pull the jammed paper out gently and slowly. Follow the steps below to clear the jam. 

  

Paper Feed Jam 

1. Remove any misfed paper by pulling it out by its visible edge. Make sure that all of the paper is properly aligned in the tray. 
 

  
 
 

2. Open and close the front or top cover to resume printing the document from failed pages.  

  

Paper Exit Jam 

1. If the paper jams as it exits to the output tray and a long portion of the paper is visible, pull the paper straight out. 
Open and close the front or top cover to resume printing. 
 

  Clearing Jams in the Paper Tray 

  Understanding the Operator Panel LEDs 

  Troubleshooting Checklist 

  Solving General Printing Problems 

  Solving Print Quality Problems

NOTE: Paper jams in this area may result in loose toner on the page. If you get any toner on your clothes, wash them in cold water as hot water will 
set the toner into the fabric.
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2. If you cannot see the paper in the output tray or the paper does not move when pulled, stop pulling and open the top cover and the inner cover. 
 

 
 
 

 

3. Loosen the paper if it is caught in the heat roller. Then remove the paper by gently pulling it out. 
 

  
 
 

 
4. Close the inner cover(1) and the top cover(2). Printing resumes automatically.  

 

 
 
 

  

NOTE: Failed pages will not reprint. Reprint the failed pages.

 CAUTION: The top and inner cover themselves may also be hot due to the heat roller(located underneath the inner cover). Allow the printer 
to cool before opening the covers. 

CAUTION:When removing jammed paper, be careful not to touch the heat roller (located underneath the inner cover). It is hot and could 
cause burns!

NOTE: Failed pages will not reprint. Reprint the failed pages.



Fuser Area Jam 

1. Open the front cover. 
 

  
 
 

2. Gently pull the toner cartridge out, being careful not to scratch against the printer, and lift it up and away from the printer. 
 

  
 
 

3. Remove the paper by gently pulling it toward you. 
 

  
 

4. Check that there is no other paper in the printer.  
 

5. Reinstall the toner cartridge and close the front cover. Your printer resumes printing the document from failed pages.  

  

Tips for Avoiding Paper Jams 

  

By selecting the correct paper types, most paper jams can be avoided. When a paper jam occurs, follow the steps outlined in "Clearing Jams in the Paper 
Tray".  

  
l Follow the procedures in "Loading Print Media in the Paper Tray". Ensure that the adjustable guides are correctly positioned. 

 
   

l Do not overload the paper tray. 
 
   

l Do not remove the paper from the tray while your printer is printing. 
 
   

l Do not add paper to the tray while your printer is printing. 
 
   

l Flex, fan, and straighten the paper before loading.  
 
   

l Do not use creased, damp, or curled paper. 
 
   

NOTICE: The fuser area is hot. Take care when removing paper from the printer.
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l Do not mix paper types in the paper tray. 
 
   

l Use only recommended print materials. See "Paper Specifications". 
 
   

l Ensure that the recommended print side of print materials is facing up in the paper tray.  

  

Understanding the Operator Panel LEDs 

The operator panel LEDs signify different things, depending on their sequences. LEDs that are off, on, and/or blinking indicate printer conditions such as 
printer status, intervention (for example, out of paper and jammed paper), or service. 
 
 The following table shows the most common LED sequences. Find the LED pattern below that matches the printer LED pattern and check the meaning and 
solution. 

 

LED Status Legend 

 

  

  

 Troubleshooting Checklist  

If the printer is not working properly, consult the following checklist. If the printer does not pass a step, follow the corresponding troubleshooting suggestions. 

LED Pattern Meaning and Suggested Solution 

   

Your printer has some problems. If this problem occurs, contact your service representative.  

     

• A paper jam has occurred. To solve the problem, see "Clearing Jams in the Paper Tray".

• The front cover is open. Close the front cover.

• The top cover is open. Close the top cover.

• The paper tray is empty. Load paper in the tray. See "Loading Paper".

• A toner cartridge is not installed. Install a toner cartridge. See "Installing the Starter Toner Cartridge".

 

• If the printer is receiving data,  blinks green slowly.

• If the printer is printing received data,  blinks green quickly.

  

 

• You pressed  while the printer was receiving data.

• In Manual Duplex mode, the first side of your job has printed. Load the paper back into the tray and press  to start printing. 

For details, see "Printing on Both Sides of Paper (Manual Duplex)".

You print in 600dpi resolution and your printer does not have enough memory to print the current job. When the Printing Status 
window appears, select one of the following options. 

• Click Cancel. An Internal error sheet prints and the current job automatically clears. Try simplifying the page layout and 
removing unnecessary graphics from your document. 

• Click Print. Your printer prints the current job in 300 dpi resolution. If a memory shortage occurs again, the Printing Status 
window will appear again and an Internal error sheet will print. The current job automatically clears. Try simplifying the page 
layout and removing unnecessary graphics from your document. 

  

In Manual Feed mode, there is no paper in the paper tray. Load paper into the tray and press  to start printing. 

     

The toner cartridge is nearly empty. Redistribute the toner to temporarily extend the life of the toner cartridge. If this does not 
improve print quality, install a new toner cartridge. See "Replacing the Toner Cartridge". 

 

Check Suggested Solutions 

Check the power cord and Check the power source by plugging into another outlet.  
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Solving General Printing Problems 

For problems with the operation of your printer, refer to the table for suggested solutions. 

the power switch.  

Make sure that  is on.  In Ready mode,  lights green. If  lights or blinks green, go to "Understanding the Operator Panel LEDs".  

Press and hold  to print a 

demo page. 

• If a demo page does not print, check the paper supply in the paper input tray.

• If the paper jams in the printer, go to "Clearing Jams in the Paper Tray". 

Check the demo page to see 
if it is printed correctly. 

If there is a print quality problem, go to "Solving Print Quality Problems". 

Print a short document from 
a software application to 
verify that the computer and 
printer are connected and 
are communicating correctly. 

• If the page does not print, check the cable connection between the printer and the computer.

• Check the print queue or print spooler to see if the printer has been paused.

• Check the software application to ensure you are using the proper printer driver and communication port. If 
printing is interrupted in progress, go to "Solving General Printing Problems".

If completing the checklist 
does not resolve the printer 
problem, check the following 
troubleshooting sections. 

• "Solving General Printing Problems".

• "Understanding the Operator Panel LEDs".

Condition Possible Cause Suggested Solutions 

The printer does not print. The printer is not receiving power. Check the power cord connections. Check the power switch and the 
power source. 

The printer is not selected as the default printer. Select your printer in the printer folder in Windows as your default 
printer. 

Check the printer for the following: After locating the problem, clear it. If a printer system error occurs, 
contact your service representative. 

• The front or top cover is not closed.

• Paper is jammed. 
 

• No paper is loaded.

• A toner cartridge is not installed or the 
installed toner cartridge is not the 
correct type.

• Close the corresponding cover.

• Clear the paper jam. See "Clearing Jams in the 
Paper Tray".

• Load paper. See "Loading Paper"

• Install a toner cartridge. See "Replacing the Toner 
Cartridge".

The printer may be in Manual Feed mode and out of 
paper. 

Add paper to the tray and press  on the printer's operator panel 

to begin printing. 

The connection cable between the computer and the 
printer is not connected properly. 

Disconnect the printer cable and reconnect it. 

The connection cable between the computer and the 
printer is defective. 

If possible, attach the cable to another computer that is working 
properly and print a job. You can also try using a different printer 
cable. 

The port setting is incorrect. Check the Windows printer setting to make sure that the print job 
is sent to the correct port. If the computer has more than one port, 
make sure that the printer is attached to the correct one. 

The printer may be configured incorrectly.  Check the printer properties to ensure that all print settings are 
correct.  

The printer driver may be incorrectly installed. Reinstall the printer driver; see "Installing Dell Software". Try 
printing a demo page.

The printer is malfunctioning. Check the LEDs on the operator panel to determine if the printer is 
indicating a system error.

Paper does not feed into the 
printer. 

Paper has not been loaded correctly. Remove paper from the tray and reload it correctly. 

There is too much paper in the tray. Remove excess paper from the tray. 

The paper is too thick. Use only paper that meets the specifications required by the 
printer. 

Printing is extremely slow. The job may be very complex. Reduce the complexity of the page or try adjusting the print quality 
settings.  
 
The maximum print speed of the printer is 14(A4) or 15(Letter) 
pages per minute. 

If you are using Windows 98/Me, the Spooling Setting 
may be set incorrectly.  

From the Start menu, choose Settings and Printers. Right-click Dell 
Laser Printer 1110, choose Properties, click the Details tab, and 
then choose the Spool Settings button. Select the desired spool 
setting. 

Half the page is blank. The page layout is too complex. Simplify the page layout and remove any unnecessary graphics from 
the document.  

The page orientation setting may be incorrect. Change the page orientation in your application. 

The paper size and the paper size settings do not 
match. 

Ensure that the paper size selected in the print settings matches 
the paper in the tray. 

The paper keeps jamming. There is too much paper in the paper tray. Remove excess paper from the tray.  
If printing on special materials, use the manual feed mode. 

An incorrect type of paper is being used. Use only paper that meets the specifications required by the 
printer. See "Paper Specifications". 

There may be debris inside the printer. Open the front cover and remove the debris. 
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Solving Print Quality Problems 

 

Print Quality Checklist 

  

Print quality problems can be resolved by following the checklist below. 

  
l Redistribute toner in the toner cartridge (see "Redistributing Toner"). 

 
   

l Clean the inside of the printer (see "Cleaning the Interior"). 
 
   

l Adjust the print resolution from the printer properties window (see "Graphics Tab"). 
 
   

l Ensure that the Toner Save mode is off (see "Graphics Tab"). 
 
   

l Clear general printing problems (see "Solving General Printing Problems"). 
 
   

l Install a new toner cartridge and check print quality (see "Replacing the Toner Cartridge").  
 

 

Printing Quality Problems 

  

The inside of the printer may be dirty or improper paper loading may reduce print quality. See the table below to clear the problem. 

The printer prints, but the text 
is wrong, garbled, or 
incomplete. 

The printer cable is loose or defective. Disconnect the printer cable and reconnect. Try a print job that you 
have already printed successfully. If possible, attach the cable and 
printer to another computer and try a print job that you know 
works. Finally, try a new printer cable. 

The wrong printer driver was selected. Check the application's printer selection menu to ensure that your 
printer is selected. 

The software application is malfunctioning. Try printing a job from another application. 

Pages print, but are blank. The toner cartridge is defective or out of toner. Thoroughly shake the toner, if necessary. See "Redistributing 
Toner". 

If necessary, replace the toner cartridge. 

The file may have blank pages. Check the file to ensure that it does not contain blank pages. 

Some parts, such as the controller or the board, may 
be defective. 

Contact a service representative. 

When you are using Window 
98, the illustrations print 
incorrectly in Adobe Illustrator. 

The setting in the software application is wrong. Print the document by selecting Download as Bit Image in the 
Advanced Options window of Graphics properties. 

Condition Suggested Solutions 

Light or faded print 

    

If a vertical white streak or faded area appears on the page: 

• The toner supply is low. You may be able to temporarily extend the life of the toner 
cartridge. See "Redistributing Toner". If this does not improve print quality, install a new 
toner cartridge.

• The paper may not meet paper specifications; for example, the paper is too moist or 
too rough. See "Paper Specifications".

• If the entire page is light, the print resolution setting is too low or the Toner Save mode 
is on. Adjust the print resolution and turn the Toner Save mode off. See "Graphics Tab".

• A combination of faded or smeared defects may indicate that the toner cartridge needs 
cleaning. See "Cleaning the Interior".

Toner specks 

 

• The paper may not meet specifications; for example, the paper is too moist or too 
rough. See "Paper Specifications".

• The transfer roller may be dirty. Clean the inside of the printer. See "Cleaning the 
Interior".

• The paper path may need cleaning. See "Cleaning the Interior".

Dropouts  If a faded areas, generally rounded, occur randomly on the page: 
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• A single sheet of paper may be defective. Try reprinting the job.

• The moisture content of the paper is uneven or the paper has moist spots on its 
surface. Try a different brand of paper. See "Paper Specifications".

• The paper lot is bad. The manufacturing process can cause some areas to reject toner. 
Try a different kind or brand of paper.

• The toner cartridge may be defective. See "Vertical repetitive defects".

• If these steps do not correct the problems, contact a service representative.

Vertical lines 

  

If black vertical streaks appear on the page, the drum inside the toner cartridge has probably been scratched. Install a 
new toner cartridge. See "Replacing the Toner Cartridge". 

Gray background 

  

If the amount of background shading becomes unacceptable: 

• Change to lighter weight paper. See "Paper Specifications".

• Check the printer's environment; very dry (low humidity) or high humidity (higher than 
80% RH) conditions can increase the amount of background shading.

• Remove the old toner cartridge and install a new one. See "Replacing the Toner 
Cartridge".

Toner smear 

  

• Clean the inside of the printer. See "Cleaning the Interior".

• Check the paper type and quality. See "Paper Specifications".

• Remove the toner cartridge and install a new one. See "Replacing the Toner Cartridge".

 Vertical repetitive defects 

  

If marks repeatedly appear on the printed side of the page at even intervals: 

• Clean the inside of the printer. See "Cleaning the Interior". After cleaning the inside of 
the printer, if you still have the same problems, install a new toner cartridge. See 
"Replacing the Toner Cartridge".

• Parts of the printer may have toner on them. If the defects occur on the back of the page, 
the problem will likely correct itself after a few more pages.

• The fusing assembly may be damaged. Contact a service representative.

Background scatter 

  

Background scatter results from bits of toner distributed on the printed page. 

• The paper may be too damp. Try printing with a different batch of paper. Do not open 
packages of paper until necessary so that the paper does not absorb excess moisture.

• If background scatter occurs on an envelope, change the printing layout to avoid printing 
over areas that have overlapping seams on the reverse side. Printing on seams can 
sometimes cause problems.

• If background scatter covers the entire surface area of a printed page, adjust the print 
resolution through your software application or the printer properties.

Misformed characters 

  

If characters are improperly formed and produce hollow images, the paper stock may be too slick. Try a different paper. 
See "Paper Specifications". 

Page skew 

  

• Ensure that the paper is loaded properly.

• Check the paper type and quality. See "Paper Specifications".

• Ensure that the paper or other material is loaded correctly and the guides are not too 
tight or too loose against the paper stack.

Curl or wave 

  

• Ensure that the paper is loaded properly.

• Check the paper type and quality. Both high temperatures and humidity can cause 
paper curl. See "Paper Specifications".

• Turn over the stack of paper in the paper tray. Also try rotating the paper 180° in the 
paper tray.

Wrinkles or creases • Ensure that the paper is loaded properly.
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• Check the paper type and quality. See "Paper Specifications".

• Turn over the stack of paper in the paper tray. Also try rotating the paper 180° in the 
paper tray.

Back of printouts are dirty 

  

• Check for leaks in the toner. Clean the inside of the printer. See "Cleaning the Interior".

• The transfer roller may be dirty. See "Cleaning the Interior".

Black pages 

  

• The toner cartridge may not be installed properly. Remove the cartridge and reinsert.

• The toner cartridge may be defective and need replacing. Install a new toner cartridge. 
See "Replacing the Toner Cartridge".

• The printer may require repair. Contact a service representative.

Loose toner 

  

• Clean the inside of the printer. See "Cleaning the Interior".

• Check the paper type and quality. See "Paper Specifications".

• Install a new toner cartridge. See "Replacing the Toner Cartridge".

• If the problem persists, the printer may require repair. Contact a service 
representative.

Character Voids 

  

Character voids are white areas where they should be solid black: 

• If you are using transparencies, try another type of transparency. Because of the 
composition of the transparency, some character voids are normal. 

• You may be printing on the wrong surface of the paper. Turn over the stack of paper in 
the paper tray.

• The paper may not meet paper specifications. See "Paper Specifications".

Horizontal stripes 

     

If horizontally aligned black streaks or smears appear: 

• The toner cartridge may be installed improperly. Remove the toner cartridge and 
reinsert.

• The toner cartridge may be defective. Install a new toner cartridge. See "Replacing the 
Toner Cartridge".

• If the problem persists, the printer may require repair. Contact a service 
representative.

Curl  

  

If the printed paper is curled or the paper does not feed into the printer, turn over the stack of paper in the paper tray. 
Also try rotating the paper 180° in the paper tray.  
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